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Entering your trial key allows you to save your projects 
and print them during your evaluation period. Entering 
your license key allows you do the same, except with-
out any time limitations. 

1. Start by opening up an image in Photoshop. 
2. Go to Filters -> Topaz Labs -> DeJPEG 4 -> Menu -> 
Enter key. 
3. You can then copy and paste or type your key in.

Important: To install the product on a second comput-
er, you will need to download Topaz DeJPEG and then 
enter your same license key.

Host-Specific Installation
Topaz DeJPEG is also compatible with Lightroom, 
Aperture and iPhoto. To use DeJPEG in any of these 
programs you will need to download and install the 
free Topaz Fusion Express add on. You can get it online 
at: www.topazlabs.com/downloads

In Windows, Topaz DeJPEG is supported by most host 
applications that support Photoshop plug-ins. This 
includes Paint Shop Pro, Photo Impact, Painter, and 
Irfanview, although there are other host programs that 
may also support Topaz DeJPEG. 

To install DeJPEG in either Paint Shop Pro, Photo 
Impact, or Irfranview first download Topaz DeJPEG 
to the default location. Then, to configure it into each 
program following the host-specific instructions on the 
next page. 

Topaz DeJPEG is a Photoshop plug-in, which means 
it won’t run by itself and requires a compatible host 
program. 

To Install
1. Close Photoshop or other image editing program if 
you are using it. 

2. Open the Topaz DeJPEG dmg or zip file, double-click 
on the Topaz DeJPEG installer, and then follow the on-
screen instructions. 

3. Your Topaz plug-ins will automatically be installed in 
your Photoshop plug-ins folder. 

4. After the installation, you will need to enter your 
license or trial key. 

Important for Mac Users: 
After installation, Topaz DeJPEG will be installed in the 
following folder: “ Macintosh HD -> Library -> Applica-
tion Support -> Topaz Labs -> DeJPEG 4”.

If your Photoshop is installed in a customized location, 
you will need to manually create a shortcut (alias) link 
inside folder “<Photoshop install folder> -> Plug-ins” 
that links to “ Macintosh HD -> Library -> Application 
Support -> Topaz Labs -> DeJPEG 4 -> Plug-ins”.

Installation

             Mac Dmg           Windows Zip
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1. First launch PaintShop Pro.

2. Go to Menu file -> Preferences -> File Locations. 
Select “Plug-ins” from the “File Types” list and click 
“Add”. 

Installation
3. Choose C:\Program Files\Topaz Labs\Topaz DeJPEG 4 
plug-ins and click “OK”. 

4. Topaz DeJPEG 4 is now available to use. Simply go to 
Effects -> Plug-ins and select “Topaz DeJPEG 4”.
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1. First launch  Photo Impact.

2. Go to File -> Preferences -> General or use shortcut 
key F6. 

3. Select Plug-ins from the Categories list. 

Installation
Then click on the           button and browse to find the 
DeJPEG 4 plug-in folder located in:  C: \ Program Files \
Topaz Labs \ Topaz DeJPEG 4 plug-ins and then click 
“OK”. 

4. Restart Photo Impact. Go to Menu -> Effect to access 
plug-in.
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1. Make sure that you have downloaded and installed 
the 8bf plug-in add-on, available on the Irfanview 
webpage. (http://www.software.com/irfanview-plugin)

2. Open Irfanview and go to Image -> Effects -> Adobe 
8BF filters. 

3. In the screen that pops up, select “Add 8BF filters” 
and navigate to the C: \ Program Files \ Topaz Labs 
\ Topaz DeJPEG 4 \ Plug-ins folder and click “OK”. 
You will then see “Topaz DeJPEG 4” in the Available / 
Loadable 8BF Filters section. 

4. To use Topaz DeJPEG 4 in the future, simply go to 
Image -> Effects> Adobe 8BF filters again and select 
“Topaz DeJPEG 4”.

Installation
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Introduction

will continue to diminish in quality every time you edit 
and save the image in the JPEG format.

Why can’t I use a Noise Reduction Program to Remove 
JPEG Compression Artifacts?
Noise reduction algorithms are not effective at remov-
ing JPEG artifacts caused by lossy compression meth-
ods because images noise is not the same as compres-
sion artifacts. Programs specialized in JPEG artifact 
elimination can easily target artifacts, successfully 
remove them and drastically improve your image with 
precision.  

JPEG Artifacts
What Are JPEG Compression Artifacts?
JPEG compression artifacts are random and unwanted 
image distortions that appear in JPEG images. Most of-
ten, JPEG artifacts appear in photos as blocks, dots and 
fringes. These artifacts are also referred to as: Checker-
boarding, and mosquito noise. 

To see if your images are being affected by JPEG arti-
facts because of compression, zoom in on the image 
and look for areas with checkerboard patterns, mos-
quito noise, fuzziness, reduced detail, reduced clarity 
or uneven color. 

What Causes JPEG Compression Artifacts?
JPEG compression artifacts are caused by the compres-
sion that occurs when you save an image in the jpeg 
format. JPEG images can be saved at different levels of 
compression and quality. Using a higher compression 
produces a lower-quality image and a smaller image 
size. Using a lower compression produces a higher-
quality image and a larger file size. 

Benefits and Consequences of the JPEG Format
Using the JPEG image format is popular because it re-
duces file sizes and allows for increased storage. Most 
web images are JPEGs for this very reason. However 
using the JPEG format also comes with unwanted and 
typically irreversible side effects. The JPEG format is a 
lossy form of compression, and as a result, image qual-
ity is lost and artifacts are introduced. Rhe quality that 
is lost from compression cannot be restored and 

For more information and to see examples visit: 
www.topazlabs.com/dejpeg



8

User Manual
To

pa
z 

 D
eJ

PE
G Topaz DeJPEG

About Topaz DeJPEG
Topaz DeJPEG is a Photoshop plug-in that uses a recent 
breakthrough in image processing technology to elimi-
nate the problems caused by JPEG image compression. 
It is the optimal way to fix JPEG images and remove 
artifacts. 

Topaz DeJPEG uses sophisticated algorithms that al-
low the user to quickly and effectively improve any im-
age without spending a lot of time tweaking settings. 
It also includes several built-in presets that serve as a 
starting point for many images.

With Topaz DeJPEG, you can recover and create high-
quality JPEG images, by eliminating the typical JPEG 
image distortions that degrade image quality. 

Topaz DeJPEG reduces lossy JPEG compression arti-
facts while recovering and retaining essential image 
detail, offering users unprecedented control over the 
clarity and quality of your JPEG Images. 

The Primary Functions of Topaz DeJPEG Include: 

1. Remove JPEG compression artifacts such as checker-
boarding and mosquito noise. 

2. Intelligent color and line enhancement to clarify 
original image detail and preserve image integrity. 

3. Fix fuziness and image blur caused by JPEG compres-
sion. 

4. Sharpen color edges.

5. Smooth color unevenness.

Introduction

To connect with other Topaz users, participate in Topaz 
contests and to see the latest tips, tricks and tutorials sign 

up for the new Topaz Forum online at:
 www.topazlabs.com/forum
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Topaz DeJPEG 4.0 Features

1. New user interface. 

2. Undo / Redo buttons. 

3. Collapsible side panels. Expand and collapse the 
preset panel and the tool panel for an adjustable 
workspace. 

4. Collapsible Tabs. Open and close the parameter 
tabs as you need them. 

5. Presets Layout. New preset format with single pre-
set preview window. 

6. Preset Navigation. Use the up / down arrow keys 
navigate the preset list and display the selected 
preset thumbnail (in preset preview window). Use 
the return (Enter) key to apply the currently selected 
preset.

7. Quick Slider Reset. Double click on the slider name 
to reset default slider values.

8. Larger Image Capabilities. Processes larger images. 

Introduction

Before Topaz DeJPEG

After Topaz DeJPEG



10

User Manual
To

pa
z 

 D
eJ

PE
G

Introduction

Before Topaz DeJPEG
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Introduction

After Topaz DeJPEG
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Work Area

Interface (Main View)

1. Presets 4. Settings and Parameters

Although the Topaz DeJPEG interface may look intimidating at first glance, don’t worry: it’s actually quite simple and 
easy to use. You’ll soon be a pro after experimenting with it for a bit. In order to make sense of the function of each of 
the various controls, we have divided the interface into a few sections:

1 2
3

4

2. Preview Window 3. Preview Navigator
Provides “snapshots” of 
accessible pre-defined
parameter settings.

Controls the editing using sliders 
to adjust the various effects.

Displays the preview of 
the original and adjusted 
image. 

Displays the region of the
preview image you are 
currently focused on. 
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Work Area

Interface (Tool Panel View)
Use the small white arrows to expand and collapse the preset panel.  You can click the white arrow            or grab the 
edge of the panel and drag it in or out.
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Work Area

Interface (No Panel View)
Use the small white arrows to expand and collapse the preset and tool panels.  You can click the white arrows                    
or grab the edge of the panels and drag them in or out.
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Work Area

Interface (Preset Panel View)
Use the small white arrows to expand and collapse the tool panel.  You can click the white arrow                or grab the 
edge of the panel and drag it in or out.
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mouse button on the preview image and drag it 
around.  When you let go of the mouse button, the 
new portion of the image will be processed and the 
result will be displayed. 

Preview Section 
The Preview section is the main element that is cen-
tered in the DeJPEG interface. The preview section 
shows you the original image and the processed pre-
view of the image. 

Switch between the Original and Preview tabs to com-
pare the filtered and un-filtered images. 

Work Area

You can also use SPACE bar to switch back and forth 
between your filtered and unfiltered image in the preview 
window.

1
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The “Ctrl +” and “Ctrl –” keys zoom in and out of the 
image, just like in Photoshop.  

You can use the arrow keys to adjust the value of the 
slider that is currently selected.  

A complete list of the shortcut keys can be found in 
the Shortcut Keys section later in this manual.

You can zoom in or out of the preview image by click-
ing the “+”, or “-” buttons below the preview image.
You can also resize the window as well by dragging 
the bottom right corner in and out. 

Please note: The minimum that you can zoom out 
is 100%. Anything below 100% hinders your ability to 
identify and remove jpeg artifacts. The ideal zoom set-
ting is 200%

Work Area

Photoshop and other host software support many Image 
Modes, such as Grayscale, RGB, LAB, CMYK, etc. Images 
can also be 8, 16, or 32 bits per channel. Topaz DeJPEG 
supports both 8 bits per channel and 16 bits per channel. 
Topaz DeJPEG supports RGB mode only. To work on black-
and-white images, first convert them to RGB mode.
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Work Area

Presets
Presets are a great way to speed up and simplify the 
whole process of using Topaz DeJPEG. Presets are set 
previews with previously defined settings that you 
can recall and reapply at any time. 

We’ve included some default presets for you and, al-
though they won’t work for every single photograph, 
they serve as excellent starting points for customized 
tweaking.  

Applying Presets 
Applying a default preset is easy and intuitive. Simply 
clicking on a preset will change all the settings in To-
paz DeJPEG to match those in the selected preset. 

To get the exact results you want, you may still want 
to go through the tabs and tweak the parameters.

Adding Presets
Sometimes it’s convenient to be able to define pre-
sets and save your settings for later use.  To do this, 
first adjust the Topaz DeJPEG parameters until you’re 
satisfied with the result. Then, click on “Save”. 

 
 

1. Presets Preview
Provides “snapshots” of 
the available pre-defined
parameter settings in-
cluded in the presets list 
below.

2

2. Presets List
Lists all of the saved pre-
sets available for use. 

1

3. Preset Options

The preset options al-
low you to save your 
presets, delete presets 
(default presents cannot 
be deleted), import new 
presets and export your 
saved presets to share 
with your friends. Remember that you can easily expand or collapse the presets 

panel by clicking on the small white arrow on the edge of the 
panel or by grabbing the panel edge and dragging it in or out.

3
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Work Area
Then enter a preset name, select the type of image 
that it is good for and then enter a description and 
click “OK”. You can also select a second image cat-
egory type that the preset is good for. 

Note that if the name you’ve entered is the same as a 
preset you’ve already defined then you will be asked if 
overwrite the previous one. 

Your preset will be automatically saved as a new file 
with a “.tpp” extension in the Topaz DeJPEG Presets 
menu and the preview is automatically generated. To 
apply it later, just click it like any other preset. 

Deleting Presets
If you’d like to delete a preset the select the preset 
name and then click on Delete.  

Please Note: Default presents cannot be overridden 
or deleted. Once you delete a preset it or overwrite it 
when saving, then it cannot be retrieved.  

Saved presets are located in the Topaz DeJPEG “Presets” folder:
C: \ Program Files \ Topaz Labs \ Topaz DeJPEG \ Presets unless 
you’ve opted to install Topaz DeJPEG into a different directory. 

Mac users have this folder at Macintosh HD / Library / Applica-
tionSupport /TopazLabs / DeJPEG / Presets. 
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Exporting Presets
To export the preset file to a certain location, click 
“Export”. 

Name your preset and save it to your desktop or 
other specified location that you have reserved for 
saved presets.

You can then share this preset file with others who 
may then import it. 

Sharing Presets
Feel free to share your saved presets by emailing 
them to your friends and having them put it into their 
Topaz DeJPEG Presets folder.  

Importing Presets
To import a preset file, click the “Import” button.

This will open up a “Browse” box to import a saved 
preset from your computer into Topaz DeJPEG. This is 
useful if you have downloaded a preset file that you’d 
like to use. 

Visit the Topaz Labs Blog which features the latest 
Photography, software and design information including 

tutorials, videos, and thoughts about both Topaz and 
non-Topaz topics.
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Work Area

Tools
You will use the various tools in the tools panel during 
your workflow to make your image adjustments.

1. Preview Navigator - Displays the region of the
preview image you are currently focused on.

2. Zoom Buttons - Use the zoom buttons to zoom in 
and out of your image. Or you can also set your image 
to fit the preview window or to view it at 100%. 

3. Preview Display Modes / Auto Brightness

4. Undo and Redo buttons.

5. Sliders and Parameters - Controls the editing pro-
cess using sliders to adjust the various effects.

6.  Additional Slider Controls - Use the “Reset All” but-
ton to reset all of the sliders values back to zero. 

1

2
3

6

Have more questions about Topaz DeJPEG 4 or any of the 
other Topaz software programs?

 Check out the new Topaz Knowledge Base online at: 
www.topazlabs.com/support/kb

4

5
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Select this (or click F1) then click on a feature in the 
Adjust interface to learn more about it. 

Users Guide
Select it to pull up this user guide.

Tech Support
Brings you to the Topaz Labs support page and 
Knowledge Base. 

Product Info
Select this to go to the Topaz DeJPEG web page to 
learn more about the Topaz DeJPEG plug-in.

Gallery
Select this to open up your Internet browser and go 
to the Topaz DeJPEG image gallery to see other user 
images enhanced with Topaz DeJPEG.

About
Select this to see what version of DeJPEG you cur-
rently have.

Menu
You can access Topaz DeJPEG’s menu by clicking on the 
“Menu…” button at the bottom of the interface. 

Enter Key
Select this to enter your trial or purchased license key. 

Work Area
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Settings & Parameters 

Parameters
 Topaz DeJPEG has two settings tabs and a total of 10 
parameters plus 3 display modes to help you achieve 
optimal image results. 

Main
The Exposure tab includes the basic and most essential 
artifact removal tools. These tools are the main ones 
that you will use, and they will resolve most of your 
jpeg artifact issues.

Reduce Artifacts
Removes the artifacts in your image. A higher value 
removes more JPEG artifacts but may also over-soften 
the image. A good rule of thumb is to start with a small-
er value and slowly increase this parameter to strike 
the perfect balance artifact removal and edge integrity. 

Smooth Color
Smooths out the color in the image. A higher value pro-
vides a smoother color, but you may loose detail if you 
set this value too high. 

DeJPEG Usage Tips:

For most users, “Reduce Artifacts” is the only feature you 
will need to use when editing images that have minor JPEG 
artifact issues. 

Be sure not to overuse the “Reduce Artifacts” slider or this 
may cause your image to lose edge sharpness. 

More advanced users, or images suffering from serious 
artifacts, may require additional use the of the sliders in 
the Advanced tab. 
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Reduces noise in the luminance (black-and-white) chan-
nel. 

Color Noise
Reduces noise in the color channels. 

Color Edge Radius
Increases the sharpness of the color edge. The param-
eter is ideal for recovering lost color detail. 

Edge Threshold
Sets the threshold above which the color edge will be 
enhanced. Use it to change the strength of the edge 
definition.  
 
Saturation
Increases saturation and evens out image color to com-
pensate for color loss due to artifact reduction. 

Add Grain
Adds monochrome grain to the image in order to make 
it look more nature. 

Sharpen
Sharpens the image’s edges in order to compensate for 
the image softening that occurs from the JPEG artifact 
removal process. This parameter works in conjunction 
with the Sharpen Radius Parameter. 

Sharpen Radius
This changes the edge size of sharpening, which is 
measured in pixels. This value adjusts how large the 
edges to be sharpened are. Use a larger value for more 
blurred areas, and a smaller area for less blurred areas. 

Advanced
The Advanced tab offers additional tools that can help 
create a well-balanced image. 

Settings & Parameters 

DeJPEG offers 3 different 
Color Viewing Modes that 
you can use to help with 
artifact removal and image 
enhancement while using 
Topaz DeJPEG.

Enable the “Auto-Brightness” feature to brighten the 
image for better viewing of artifacts in dark areas. Auto-
Brightness is for previewing only, your image will not 
stay brightened once you process your adjustments. 
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Workflow
We will be using this artifact-damaged image for our 
example. The goal for this image is to remove the ar-
tifacts that are distorting the image and enhance the 
edges and lines. In the following steps, we will show 
you how to achieve optimal results with your own 
photos, following this model. So, let’s get started.

1. Open an image file. 

2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”. You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

Sample Project #1
In this section, we will walk you through a sample 
project, step-by-step, to help you become more famil-
iar with the DeJPEG program focusing on using the 
default presets.

Before Topaz Adjust

After Topaz Adjust
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We want to remove the checker-boarding artifacts 
that are distorting the image, and reestablish the 
character of the image. To achieve this we will be 
working with the presets for this example, but you 
can start any way you like.

3. To begin working on your image go to Filters -> 
Topaz Labs -> DeJPEG 4.

4. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image. Then you can 
click on the preview and drag it around until you find 
an area that you like. 
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Normal Mode (Auto-brightness disabled) 
By default your mode is set to Normal when editing in DeJPEG. For most images this mode is sufficient for removing 
artifacts. More advanced users however, may want to incorporate the use of all three modes for optimal precision in 
removing artifacts. The Auto-brightness feature is disabled here making the image darker and artifacts less visible. 
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Luminance Mode
Changing the Preview Display Mode to Luminance (black-and-white channel) provides another helpful view for identify-
ing jpeg artifacts within your image.  
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Workflow

Color Mode
Changing the Preview Display Mode to Color provides another helpful view for identifying jpeg artifacts within your im-
age.  
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Workflow

If you are satisfied with the preset adjustments then 
you can click “OK” to process your image and save it 
back to Photoshop. Since I am happy with the imme-
diate results I will go ahead and click OK to save and 
process my changes. 

For this example, only the Very Noisy JPEG preset was 
used to correct recover this JPEG image. 

For more information on incorporating manual adjust-
ments please see Sample Project #2 on page 33.

5. If you want to choose a default preset, scroll 
through the panel on the left side of the screen. 
To select it, just click on it and the sliders will 
automatically adjust to the pre-defined settings 
and parameters. For this example we will be 
using the Very Noisy JPEG preset.

Don’t forget that you can use the shortcut keys in 
Topaz DeJPEG 4 to speed up your workflow.
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Workflow

Before Topaz DeJPEG
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Workflow

After Topaz DeJPEG
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You can see the difference in detail and color in the 
two images because the original is damaged from 
compression.  In the following steps, we will show 
you how to achieve optimal results with your own 
photos, following this model. Let’s get started.

1. Open an image file. 

2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”. You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

Sample Project #2
In this project, we will walk you through a second 
DeJPEG workflow to show you how to better achieve 
optimal and natural-looking image results using the 
sliders in the Advanced tab. 

                                

                                                    

Workflow

After Topaz DeJPEG

Before Topaz DeJPEG

Don’t forget that you can use the shortcut keys in 
Topaz DeJPEG 4 to speed up your workflow.
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the presets and sliders for this example, but you can 
start any way you like.

 5. If you want to choose a default preset, scroll 
through the panel on the left side of the screen. To se-
lect it, just click on it and the sliders will automatically 
adjust to the pre-defined settings and parameters. For 
this example we will be using the Highly Compressed 
JPEG preset.

3. To begin working on your image go to Filters -> 
Topaz Labs -> DeJPEG 4

4. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image. Then you can 
click on the preview and drag it around until you find 
an area that you like. 

We want to remove the color artifacts that are dis-
torting the image, and reestablish the character of the 

Workflow
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Start in the Main tab. It is a good idea to begin here, 
starting with the Reduce Artifacts slider and then 
progress to the Sharp Radius slider in order to see the 
effects of your adjustments easily. 

1. You should already be in the “Normal” color mode. 
Switch to the “Luma” color mode. This is the black-
and-white mode which enables you to see the image 
without color artifacts. 

With a variety of presets you will often find that a 
single selection will give you optimal image results. 

If you are satisfied with the preset adjustments then 
you can click “OK” to process your image and save it 
back to Photoshop.

If you would like to make some additional adjust-
ments to your enhancement settings then you can do 
so by adjusting any of the sliders in the two tabs man-
ually until you achieve your preferred image results. 

 
 

Workflow
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Workflow
4. Switch to the “Color” mode. If you find that the col-
or in your image is a little uneven, adjust the “Smooth 
Color” slider to clean these areas.

The Main tab will generally be all you need to use 
when making adjustments. However if you feel your 
image needs additional work then continue on to the 
Advanced tab. 

5. If you find that there is noise in your image, you can 
reduce it by using the “Luma Noise” and “Color Noise” 
sliders. First, switch back to “Luma” mode and apply the 
“Luma Noise” adjustment. Then, return to “Color” and 
apply the “Color Noise” adjustment until you are satis-
fied. This will help clear up a noisy image. 

6.  Now, still in “Color” mode, you can improve color 
edge detail, by going to “Clr Edge Radius” and raising the 
value of that slider. Use it along with “Edge Threshold” 
to set the strength of the edge definition.

7. Color can also sometimes be weakened in the artifact 
reduction process. You can fix this by going to “Satura-
tion” and raising the value of this slider to recover some 
color and balance out the saturation in the image.

8. Finally, you can add in some grain to make the final 
image look a little bit more natural with the “Add Grain” 
slider. This is set at a default value of 0.05.

 

2. In “Luma” mode, go to the “Reduce Artifacts”slider 
under the Main tab and adjust it to a level where you 
are satisfied. Since a higher value may soften the 
edges, it’s a good idea to start with a small value and 
slowly increase it. That way, you can be sure that you 
sufficiently remove artifacts while preserving edge 
integrity.

3. Then move to “Sharpen.” If you find that you have 
lost some edge detail by reducing blockiness, you can 
move this slider up to recover it. Use it with “Sharpen 
Radius” to control edge harshness. Higher levels are 
good especially for blurred areas.

Your image should now be free of JPEG artifacts. To 
modify any additional aspects of the image, proceed 
with the next steps.

The best way to get great-looking images is to experiment with 
the filter until you’re satisfied. Despite the number of sliders and 
settings, getting a great result is easier than you might think!Need to reset your slider values? 

Simply  double-click on the slider name above the slider 
control to instantly reset the slider value to 0. 
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9. Once you are happy with your preset selection and 
your manual adjustments you are ready to click OK 
and watch your image transform. 

Topaz DeJPEG 4 gives you luma noise and color noise 
tools which are specific to jpeg artifact removal. However, 
if you are looking for more extensive noise reduction 
good for any image, be sure to check out Topaz DeNoise. 

After Topaz DeJPEG

Before Topaz DeJPEG

Please visit the Topaz DeJPEG website at http://www.
topazlabs.com/dejpeg for video tutorials, tips, and 

tricks!
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Before Topaz DeJPEG
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After Topaz DeJPEG
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Glossary
made up of a specific primary color. In a typical digi-
tal photo, the primary colors of red, green and blue 
(from the RGB color model) create all the colors in 
that photo, which may be represented by three color 
channels, each of red, green or blue.

Color Noise – A type of digital noise in which color 
edges are blurred or the image is unevenly colored 
and filled with spots.

Color Profile - defines the range of colors that can ap-
pear in a digital photo.

Compression - The process of encoding digital infor-
mation using fewer bits.

Compression Artifacts – Fuzziness or distortion in 
a compressed image or sequence of video images 
caused by lossy compression, i.e., into a JPEG format.

Download - The process of transmitting or transfer-
ring data from one device to another.

Edge Artifacts – The “ringing” artifacts or distortions 
found around image edges.

Export - Outbound data transfer in a format that can 
be used by other programs.

Grain –Lightly speckled noise that is used to apply a 
more natural look to an image. 

HDR (High Dynamic Range) - Allows a greater dynamic 
range of luminances between the lightest and darkest 
areas of an image than standard digital imaging tech-
niques or photographic methods. This wider dynamic 

Achromatic - Without color.

Algorithm - Any bit of code or programming that de- 
fines a process.

Artifact- Any undesired alteration in data introduced 
during its digital processing.

Blur - Make or become unclear or less distinct.

Brightness - The degree to which a color sample ap-
pears to reflect light. 

Checkerboarding – A type of distortion that shows up 
as abnormally large pixel blocks in the image; tends to 
show up in areas with lots of information; usually only 
occurs with highly-compressed images.

Chroma - Purity or intensity of color. The difference 
of a color against the brightness of another color that 
appears white under similar viewing conditions.

Clean Color – A parameter that controls the amount 
of color noise to reduce.

CMYK - Cyan, magenta, yellow, and black. A color 
model commonly used for 4-color printing by printers 
to define and mix all of the colors they are capable of 
outputting.

Color - The human perceptual response to different 
wavelengths of light impinging on the photo recep-
tors in the retina.

Color channel - The visual component of a color digi-
tal image that represents all the pixels in that picture 
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that detracts from overall image quality or something 
you can choose to create artistically.

Pan and Zoom - A useful function that allows users to 
magnify the captured image in the preview and then, 
by using the cursor, to move or pan around the image. 
Typically Pan and Zoom allows users to magnify the 
image 2x or 4x time. By magnifying the images and 
zeroing in on a specific section, you can see details 
not visible when the entire image is sized to fit the 
preview.

Parameter - A numerical or other measurable factor 
forming one of a set that defines a system or sets the 
conditions of its operation.

Photo-editing or Imaging software – Programs in 
which you can alter your photos and / or create digital 
images. Depending on the software, you can improve 
exposure, color and other attributes of your picture, 
paint on it, add type, apply special effects, remove 
noise, resize it, combine it with other pictures, pre-
pare it for e-mail or posting on the web, output it to a 
printer, or do any number of other manipulations or 
edits.

Plug-in - A computing feature with the ability to be 
added to a system to give extra features or functions.

Preset - A pre-defined combination of parameters and 
settings that is saved into a folder within Topaz Detail 
2. Topaz provides default presets. A preview of each 
preset can be seen in the preset preview window lo-
cated at the top left hand side of the interface above 
the preset list. 

range allows HDR images to more accurately repre-
sent the wide range of intensity levels found in real 
scenes, ranging from direct sunlight to faint starlight.

Image - An array of pixels that make up a digital pic-
ture. 

Import - Inbound data transfer into a file or docu-
ment.

ISO - The amount of sensitivity of a digital camera sen- 
sor. A higher ISO enables faster shutter speeds and/or 
better performance in low light, but is more suscep-
tible to experiencing increased noise.

Lossless Compression - A reversible way of reducing 
the size of data while preserving it.

Lossy -  Computing of or relating to data compression 
in which unnecessary information is discarded.

Lossy Compression - An irreversible way of reducing 
the size of data by approximating it.

Luma (Luminance) - The brightness in an image (the 
“black” and “white” or achromatic portion of the im-
age). Luma represents the achromatic image without 
any color, while chroma components represent the 
color information.

Noise - Visible effects of interference in an image from 
a digital camera. Often appearing as random colored 
dots sprinkled throughout the image or uneven col-
oration in what should be smoothly-colored areas. It 
is most likely to show up in the darker or shadowed 
areas of an image. Noise can be an undesirable effect 
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Preview- Shows the processed preview of the image.

RAW image - An image file format that contains un- 
touched, “raw” pixel information straight from the 
digital camera’s sensor. It has yet to translate the in-
formation in each pixel into the full color information, 
so this format offers more control over how the final 
JPEG or TIFF image is generated. 

Reduce Blur - An de-blur function that uses decon-
volution technology rather than simple sharpening 
techniques.

Refine – Improve (something) by making small changes to 
make it more subtle and accurate. 

RGB - Red, Green, Blue. The color model that is used in 
digital cameras and by computer monitors.

Sharpness - The clarity of detail in a photo.

Smoothing - To make a surface more regular or con- 
sistent; free from perceptible projections, lumps, or 
indentations.
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into the Photoshop Plug-Ins folder. 
3. Quit and restart Photoshop and Topaz DeJPEG 4 will 
appear in your Filters menu. 

“Do you have any other DeJPEG tutorials?”
Yes, please see pages 25 and 33 of this Topaz DeJPEG 
user guide, and also visit: http://www.topazlabs.com/
tutorials/dejpeg

“I do not have Photoshop, will  DeJPEG work with my 
Elements, Aperture, Lightroom, iPhoto Paint Shop 
Pro, Photo Impact or Irfanview?”
Yes, you can use Topaz DeJPEG with any of the above 
host programs. However, to use DeJPEG in Aperture, 
Lightroom or iPhoto, you will need to download the 
free Topaz Fusion Express add-on. For more informa-
tion please visit: www.topazlabs.com/fusion

“What are the limitations of the trial version of your 
software?”
The only limit on the trial versions of the Topaz plug-ins 
is time. The free trial versions are designed to enable 
you to experience the full functionality of our plug-ins 
for a 30-day trial period. After the trial period is up, you 
will only be able to use the Topaz software by purchas-
ing it. You will then receive a license key to activate the 
plug-in, and the trial version will automatically become 
the full version with no time limitations.          

“I need a Topaz DeJPEG trial key.” 
Visit http://www.topazlabs.com/downloads for a trial 
key. Please check your Spam folder because your Spam 
filter sometimes filters out the automated email. 

If you need more time to evaluate, please contact us at: 
www.topazlabs.com/support
 

 “I can’t find Topaz DeJPEG in the Photoshop Filters 
menu.” 
If you’re using Windows: 
1. Go to C: \ Program Files \ Topaz Labs \ Topaz DeJPEG 
4 \ Plugins. Right click the file “tldejpeg4.8bf” and click 
“Copy”. 
2. Go to your Photoshop Plug-Ins folder, usually located 
at C: \ Program Files \ Adobe \ Adobe Photoshop CSx \
Plug-Ins. First, delete anything that is currently there 
that has to do with Topaz DeJPEG 4 This includes any 
folder that might be labeled “Topaz DeJPEG 4” or any 
tldejpeg4.8bf file. After doing that, right-click on any 
empty space and click “Paste”. 
3. Quit and restart Photoshop and Topaz DeJPEG will 
appear in your Filters menu. 

If you’re using Mac: 
1. Go to Macintosh HD / Library / Application Support / 
Topaz Labs /dejpeg4 / Plug-ins and right-click Topaz_De-
JPEG4.plugin. Click “Copy”. 
2. Go to Applications/Adobe Photoshop CSx / Plug-Ins 
(or wherever your Photoshop Plug-Ins folder is locat-
ed). Delete any current reference to Topaz DeJPEG 4. 
Afterwards, right-click any 

Frequently Asked Questions
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Frequently Asked Questions
“If I use the 30-day trial version will I need to uninstall 
the trial version before I upgrade to a full version?”
No, the Topaz trial software is designed to be unlocked 
to become the full version simply by entering a license 
key. The full license key will be e-mailed to you immedi-
ately after you purchase the software.

“Where do I enter my key?”
To enter your key please open an image in Photoshop 
and go to Filter -> Topaz Labs -> DeJPEG 4 -> Menu -> 
Enter Key. You can then copy & paste or type in your 
license key and then select OK.

“I had Topaz DeJPEG as a trial, then I purchased. How 
do I enter my new license key?”
You can enter your new license key by opening up an 
image in Photoshop and go to Filter -> Topaz Labs -> 
DeJPEG 4 -> Menu -> Enter Key. Please remove the trial 
key and enter your new purchased license key, then 
select OK and you are all set. 

“My Topaz DeJPEG key doesn’t work!”
There are a couple of reasons why Topaz DeJPEG might 
think your license key is invalid.

First, make sure that your key is in the proper format. 
It’ll be in the format “xxxxxx-xxxxxx-xxxxxx-xxxxxx-
xxxxxx” and will be all numbers in 30 digits in five 
groups of six (no letters). 

Second, make sure that as you’re entering the key 

there is nothing in the space beforehand. This means 
clicking, pressing Ctrl-A, and hitting delete to make sure 
that absolutely nothing is in that field before you paste 
in the key.

If it doesn’t work when you copy and paste, try typing 
it out, and vice versa.

My Topaz filters are grayed out in the filter menu. 
Please make sure that you are using a 8-bit or 16-bit 
image that is in RGB color mode. This will allow you to 
access your Topaz programs.  

I have a question not listed here. 
Please visit our knowledge base online at: 
http://www.topazlabs.com/support/kb/

If you are not able to find the answer there then please 
visit our new Topaz Forum online at: www.topazlabs.
com/forum or contact us at: www.topazlabs.com/sup-
port

http://www.topazlabs.com/support/kb/
http://www.topazlabs.com/forum 
http://www.topazlabs.com/forum 
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Shortcut Keys
Topaz DeJPEG uses some shortcut keys to speed up your workflow. Many of these 
keys are similar to those in Photoshop. The following keys work at all times.  

ADDITIONAL SHORTCUTS

View Original Image             Spacebar               Spacebar 
Reset All              CMD-ALT-R         CTRL-ALT-R
Zoom In             + or CMD - +        + or CTRL - +
Zoom Out              - or CMD - -         - or CTRL - -
Undo               CMD -Z         Ctrl - Z 
Redo               CMD - Shift - Z       Ctrl - Shift - Z

  Action                   MAC Shortcut               PC Shortcut

M      Expands / Collapses Main Tab 
A      Expands / Collapses Advanced Tab
Left or Right Arrow Key   Scrolls through presets
Return (enter) key    Applies selected preset
[ key       Reduces selected slider value by 0.1
] key      Increases selected slider value by 0.1
Home Key      Set the slider value to minimum
End Key     Set the slider value to maximum
Double-click slider name   Resets the slider value to 0

  Action                   Shortcut
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Connect with Topaz

Follow us on Twitter for notifications of 
recent news and easily get in touch with us 

whenever you feel like it!

Find us on our Facebook page and network 
with other Topaz users!

Participate in the entirely user-led Topaz 
Flickr group for a helpful and highly active 
community for Topaz Photoshop plug-ins!

Subscribe to our YouTube channel to keep 
up with any newly released product video 

tutorials!

Check out our new Forum and our blog for 
tutorials, tips and updates from Topaz Labs!

http://www.topazlabs.com/forum
http://www.facebook.com/pages/Topaz-Labs/19955996369
http://www.flickr.com/groups/topaz
http://twitter.com/topazlabs
http://www.youtube.com/topazlabs
http://www.topazlabs.com/forum
http://www.topazlabs.com/blog
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Topaz Labs LLC, a privately owned company in Dallas, Texas, focuses on developing advanced video and image enhance-
ment technology. With today’s widespread use of digital still cameras, digital video cameras, and HDTV, the need for high-
quality digital images and videos has greatly increased. Topaz Labs’ mission is to bring practical state-of-the-art image and 
video enhancement technology to both professionals and consumers.

Contact Information
 

Topaz Labs LLC
5001 Spring Valley Road
Suite 400 East
Dallas, TX 75244

Technical Support
Visit: http://topazlabs.com/support/

Copyright © 2009 Topaz Labs, LLC. All rights reserved. http://www.topazlabs.com
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Image Plug-ins    

Go to http://www.topazlabs.com/downloads to get your 30-day free trial!

Ultimate control over 
image exposure, detail, 
and color gives you the 
power to make your 
photos pop.

Specializes in creat-
ing crisp and stylized 
images. Also features 
extensive smoothing 
capabilities. 

Advanced noise reduc-
tion filters noise while 
maximizing and retain-
ing image detail simply 
and effortlessly.

Takes any of your 
regular photos and ef-
fortlessly turn them into 
beautiful works of art.

Specializes in overall 
image improvement. 
Features sharpening, re-
constructing, enlarging, 
high-quality noise 
removal and JPEG arti-
fact damage tools. 

Increase video quality with this suite 
of video enhancement filters utilizing 
super-resolution technology. 

Advanced JPEG artifact 
reduction filters elimi-
nate JPEG compression 
artifacts while preserv-
ing image detail like 
never before. 

Video Plug-ins 

3 levels of intricate and 
specific detail enhance-
ment for naturally 
enhanced images with 
no halos. 

Bring the power of 
Topaz to your Aperture, 
iPhoto and Lightoom 
workflow with the new 
Fusion Express plug-in.

Remove unwanted 
backgrounds from your 
digital images quickly 
and easily with the new 
Topaz ReMask. 

Easily and efficiently capture video 
frames and significantly increase their 
quality and resolution with this stand-
alone Windows application. 


